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I. Definitions 

1. OS 
Windows, Android, Linux 
 

2. Sensor 
Primesense, Xtion, 
 

3. Language Locale 
Locale Id String – A string representing a specific language type. Examples: 
 
zh-cn           Chinese – China 

 
zh-hk           Chinese - Hong Kong 

 
zh-mo          Chinese - Macau 

 
zh-sg           Chinese – Singapore 

 
zh-tw            Chinese – Taiwan 

 

 
 
 
 

II. Developing the application 

1. General 
 
Gesture-controlled (aka “motion-sensing”) devices are changing the way people 

interact with games and apps. You can take part in the gesture-controlled 

revolution by joining the appside marketplace. We know how important 

distribution and monetization are; we work to get you market access so you can 

offer apps and games across many gesture-controlled platforms. Since we’re 

pre-installed on consumer electronics devices we’re happy to work with you in 

this exiting market 



 

 

Making it professional 

Sometimes the line between an app that looks like a 'hack' and an app that looks 

‘professional’ are some simple user experience and interface implementations. If 

you're aspiring to get placement in the AppSide Marketplace, you'll need these extra 

touches so that end-users will be willing to pay for your creation. The easiest is to 

look to your favorite iOS or Casual PC games for inspiration: At launch, display a 

sequence of Splash Screens showing: 

    Your name / your developer name, including a Logo if you have one 

    The middleware logo e.g: OpenNI logo 

    Then the Main Menu 

    Think of how a movie’s opening credits look; that’s what you’re shooting for. 

    On the Main Menu: 

  Prominently display the name of the game, presented as a logo 

if you have one. 

  Show several easily ‘selectable’ looking buttons to choose from: 

  New Game, or Play, or Start

  If applicable: “Continue Game”

  Load Game (if applicable)

  New Player (or Change Player if already defined)

  Options

  Credits

  Exit

  Simple and understandable tutorial that will explain all games gestures

  Simple gestures and not too many

  Legal rights to all games assets

   

 

 



 

 

2. Requirements 
 

Clone Mode - 720p resolution only 
 

3. Application Name 
 
The name of the application installation folder you are developing should be 

unique. If an application with the name you selected already exists in the 

AppSide marketplace you will need to select a different name. 

If you select a name that is already used by another application, you will be 

notified by AppSide and you will need to select a different name. 

We will refer to this as AppName in the rest of the doc. 

 

4. Structure 
This section describes the structure of the application for Windows OS. 

 

5. Windows 
The application you develop should consist of one or more binary files (exe, dll, 

lib, fla, jar etc.) and many more files such as xml, image files, text files, config 

files, sound files etc. 

 

6. Binary files 
 
All binary files  must be under %ProgramFiles%\AppName 

(Win 32 bit - “C:\Program Files\AppName” 

Win 64 bit - “C:\Program Files (x86)\AppName”) 

They may be installed directly or under another sub folder such as bin. Binaries 

should be compiled to run on 32 bit devices. 



 

 

 

7. Data files 
 

All other files should be under “%ProgramData%\AppName” 
 

(“C:\ProgramData\AppName”) in any structure. 
 
Alternatively, config files that get written at INSTALL time but not for user 

updatable data can be written under “C:\Program Files (x86)\AppName” 

 
8. User specific files 

 
Files holding user specific data such as settings  must be written 

 

under “%appdata%\AppName” 

(“C:\Users\username\AppData\Roaming\AppName”). 

 

9. Updatable Files 
 
Files written by the game during run time must be written under 

 
“%ProgramData%\AppName” or 

 
“%appdata%\AppName” 

 
As described above 

 



 

 

III. Submitting the Application 

1. Test the application 
 

Before submitting the application, test the game thoroughly. Buggy Applications 

and Applications that do not meet the AppSide Marketplace standards will be 

rejected. 

 

2. Create store images 

 
In order to display the game in the AppSide Marketplace you will need to create 

icons, thumbnails and screenshots in the following manner: 

1.   Create one square icon as a png file 512x512 pixels. 

2.   Create one rectangle thumbnail as a png file with aspect ratio 

of 3:4 and minimum dimension of 400x300 pixels. 

3.   Create several (up to 4) screenshots of selected parts of 

the application. These should be jpg files with aspect ratio 

of 3:4 and minimum dimension of 1200x900 pixels. 

4.   Optional movie file. 

 

Each image should be smaller than 300KB. 

 

 

 

 

 

 

 



 

 

3. Submit to AppSide Marketplace 
  

Submitting the developed game requires 3 steps: 

1.   Create one folder with the name of the application and it’s version 

(AppName_V1.0) 

Under this folder Create 4 folders: 

App – all files that reside under “C:\Program Files (x86)\AppName” 

ProgramData - all files that reside under %ProgramData%\AppName” 

AppData - all files that reside under “%appdata%\AppName” 

StoreImages – icons, thumbnails and screenshots used by AppSide 

MarketPlace. 

2.   Zip the root folder using the application name and version 

(AppName_V1.0.zip)



 

 

3.   Fill in the AppSide configuration XML: 

 
<ApplicationName> App Name </ApplicationName> Application 

 
Name in the 

default 

language 

<AppInstallName>AppName</AppInstallName> The name of 
 
the folder where 

the app will be 

installed, under 

Program Files, 

Program Data 

and registry 

<Description>Application description</Description> the Application 
 
description in 

the default 

language as it 

will be 

displayed in the 

Store 

Game/Applicati 

on page and in 



 

 

 Xtion portal 

<Developer>developer name</Developer>  

<Images> 
 

<Icon>BubblePop-icon.png</Icon> 
 

<Thumbnail>BubblePop-Thumb.png</Thumbnail> 
 

<Screenshot>screen01.jpg</Screenshot> 
 

<Screenshot>screen04.jpg</Screenshot> 
 

<Screenshot>screen07.jpg</Screenshot> 
 

<Screenshot>screen08.jpg</Screenshot> 
 
</Images> 

 

<Video>BubblePopPromo.avi</Video>  

<builds> List of target 
 
segment 

<build> For each target 
 
segment 

<FileInfo> File parameters 
 
for each target 

segment 

<ExecutionFile> game.bat </ExecutionFile> Relative path 
 
(from App 

directory) to the 

file used to 

 



 

 

 

 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 launch the 
 
application 

<Processes> 
 

<Process>AppName.exe</Process> 
 

<Process>Launcher.exe</Process> 
 

</Processes> 

List of 
 
processes that 

are running. 

Needed for 

upgrade 

process and to 

avoid two 

instances 

running 

simultaneously 

<ProtectedFiles> 
 

<file>LauncherData\Game\game.exe</file> 
 

<file>LauncherData\Launcher.exe</file> 
 
</ProtectedFiles> 

Relative path 
 
(from App 

directory) to the 

files that need 

to be protected 

via DRM 

  

</FileInfo>  

<TargetInfo> Target 
 
parameters for 



 

 

 

 

 each target 
 
segment 

<OpenNIVersion></OpenNIVersion>  

<OS></OS>  

<Sensor></Sensor>  

</TargetInfo>  

</build>  

</builds>  

<Languages>  

<Language> For each 
 
language there 

will be a node 

with the 

following nodes 

<Locale>locale name</Locale> The language 
 
locale. 

 
List of locales 

can be found in 

appendix 1 and 

in the sample 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

-



 

 

 

 

 config.xml. 

<Name>AppName</Name> Application 
 
name 

according to 

language. 

If left empty the 

default will be 

used. 

<Description> Cool App! </Description> Description 
 
according to 

language. 

If left empty the 

default will be 

used. 

</Language>  

</Languages>  

  

  

  

  

  

  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

IV. Segmentation 

1. General 
A Segment is defined as a group of devices and users targeted to receive a 

certain look, feel or functionality of the Application. 

The best example of a segment is users from a certain country speaking a 

certain language. It is possible that the developer will want messages and texts 

displayed in the native language of the user. 

 

2. Implementation 
For each game instance which includes a different set of files a new zip file 

should be provided with all the files. 

Each such build will have its own set of files and targeting section in the 

confi.xml. 

 

3. Best Practices 
In order to support segmentation, the developer should create the Application in 

such a way that there is one copy of the Application which can display itself 

differently according to different configuration settings or inputs from the user. 

 

 
 



 

 

 

Example: 

The Application can contain a folder called languages. Under that folder there can be a 

folder for each language. 

Each language folder will contain all text, configuration, image and sound files 

with language specific content. 

 

Upon user selection of language or automatically recognizing the OS locale, the 

application will use the files form the relevant language folder. 

 

It is best minimize the use of image and sound files for segmentation and try to 

use configuration and text files instead. 

 

Example: 

Inserting a title into an image file is not recommended; instead the Application 

should draw the title over the image. 

In such implementation, there will be one image with many text files with the 

translated title instead of many copies of the same image thus dramatically 

reducing the size of the Application. 

 
 
 
 
 
 
 
 
 
 



 

 

V. Versioning 

1. General 
Each time an application build is uploaded to the AppSide Marketplace it will 

receive a version. 

This version is important for communication between the developer and AppSide 

Marketplace and should be remembered by the developer. 

 

 

 

VI. Upgrades 

1. General 
Similar to submitting the Application. 

Give the game files and some parameters to AppSide. Appside will handle the 

DRM, packaging and upgrading of the Application. 

Please refer to the “Submitting the Application” section for submitting a new 

version of the Application 

 



 

 

 

Locale ▾  
Language  

code 

LCID 
 
string 

LCID  

Decimal 

LCID 

Hexadecimal 

 

Afrikaans af af 1078 436  

Albanian sq sq 1052   

Amharic am am 1118   

Arabic - Algeria ar ar-dz 5121 1401  

Arabic - Bahrain ar ar-bh 15361   

Arabic - Egypt ar ar-eg 3073   

Arabic - Iraq ar ar-iq 2049 801  

Arabic - Jordan ar ar-jo 11265   

Arabic - Kuwait ar ar-kw 13313 3401  

Arabic - Lebanon ar ar-lb 12289 3001  

Arabic - Libya ar ar-ly 4097 1001  

Arabic - Morocco ar ar-ma 6145 1801  

Arabic - Oman ar ar-om 8193 2001  

Arabic - Qatar ar ar-qa 16385 4001  

Arabic - Saudi Arabia ar ar-sa 1025 401  

Arabic - Syria ar ar-sy 10241 2801  

Arabic - Tunisia ar ar-tn 7169   

Arabic - United Arab 
Emirates 

ar ar-ae 14337 3801  

 

VII. Appendix 1 – List of Locales 



 

 

  
 

Locale ▾  
Language 

code 

LCID 
 

string 

LCID  

Decimal 

LCID 

Hexadecimal 

Arabic - Yemen ar ar-ye 9217 2401 

Armenian hy hy 1067  

Assamese as as 1101  

Azeri - Cyrillic az az-az 2092  

Azeri - Latin az az-az 1068  

Basque eu eu 1069  

Belarusian be be 1059 423 

Bengali - Bangladesh bn bn 2117 845 

Bengali - India bn bn 1093 445 

Bosnian bs bs 5146  

Bulgarian bg bg 1026 402 

Burmese my my 1109 455 

Catalan ca ca 1027 403 

Chinese - China zh zh-cn 2052 804 

Chinese - Hong Kong SAR zh zh-hk 3076  

Chinese - Macau SAR zh zh-mo 5124 1404 

Chinese - Singapore zh zh-sg 4100 1004 



 

 

 

Locale ▾  
Language 

code 

LCID 
 

string 

LCID  

Decimal 

LCID 

Hexadecimal 

Chinese - Taiwan zh zh-tw 1028 404 

Croatian hr hr 1050  

Czech cs cs 1029 405 

Danish da da 1030 406 

Divehi; Dhivehi; Maldivian dv dv 1125 465 

Dutch - Belgium nl nl-be 2067 813 

Dutch - Netherlands nl nl-nl 1043 413 

Edo   1126 466 

English - Australia en en-au 3081  

English - Belize en en-bz 10249 2809 

English - Canada en en-ca 4105 1009 

English - Caribbean en en-cb 9225 2409 

English - Great Britain en en-gb 2057 809 

English - India en en-in 16393 4009 

English - Ireland en en-ie 6153 1809 

English - Jamaica en en-jm 8201 2009 

English - New Zealand en en-nz 5129 1409 

 

 
 
 
 
 
 



 

 

 
 

Locale ▾  
Language 

code 

LCID 
 

string 

LCID Decimal LCID 

Hexadecimal 

English - Phillippines en en-ph 13321 3409 

English - Southern Africa en en-za 7177  

English - Trinidad en en-tt 11273  

English - United States en en-us 1033 409 

English - Zimbabwe en  12297 3009 

Estonian et et 1061 425 

FYRO Macedonia mk mk 1071  

Faroese fo fo 1080 438 

Farsi - Persian fa fa 1065 429 

Filipino   1124 464 

Finnish fi fi 1035  

French - Belgium fr fr-be 2060  

French - Cameroon fr  11276  

French - Canada fr fr-ca 3084  

French - Congo fr  9228  

French - Cote d'Ivoire fr  12300  

French - France fr fr-fr 1036  



 

 

 

Locale ▾  
Language 

code 

LCID 
 
string 

LCID 

 Decimal 

LCID 

Hexadecimal 

French - Luxembourg fr fr-lu 5132  

French - Mali fr  13324  

French - Monaco fr  6156  

French - Morocco fr  14348  

French - Senegal fr  10252  

French - Switzerland fr fr-ch 4108  

French - West Indies fr  7180  

Frisian - Netherlands   1122 462 

Gaelic - Ireland gd gd-ie 2108  

Gaelic - Scotland gd gd 1084  

Galician gl  1110 456 

Georgian ka  1079 437 

German - Austria de de-at 3079  

German - Germany de de-de 1031 407 

German - Liechtenstein de de-li 5127 1407 

German - Luxembourg de de-lu 4103 1007 

German - Switzerland de de-ch 2055 807 



 

 

 

 

 

Locale ▾  
Language 

code 

LCID 
 
string 

LCID  

Decimal 

LCID 

Hexadecimal 

Greek el el 1032 408 

Guarani - Paraguay gn gn 1140 474 

Gujarati gu gu 1095 447 

HID (Human Interface Device)   1279  

Hebrew he he 1037  

Hindi hi hi 1081 439 

Hungarian hu hu 1038  

Icelandic is is 1039  

Igbo - Nigeria   1136 470 

Indonesian id id 1057 421 

Italian - Italy it it-it 1040 410 

Italian - Switzerland it it-ch 2064 810 

Japanese ja ja 1041 411 

Kannada kn kn 1099  

Kashmiri ks ks 1120 460 

Kazakh kk kk 1087  

Khmer km km 1107 453 



 

 

 

 

Locale ▾  
Language 

code 

LCID 
 
string 

LCID 

 Decimal 

LCID 

Hexadecimal 

Konkani   1111 457 

Korean ko ko 1042 412 

Kyrgyz - Cyrillic   1088 440 

Lao lo lo 1108 454 

Latin la la 1142 476 

Latvian lv lv 1062 426 

Lithuanian lt lt 1063 427 

Malay - Brunei ms ms-bn 2110  

Malay - Malaysia ms ms-my 1086  

Malayalam ml ml 1100  

Maltese mt mt 1082  

Manipuri   1112 458 

Maori mi mi 1153 481 

Marathi mr mr 1102  

Mongolian mn mn 2128 850 

Mongolian mn mn 1104 450 

Nepali ne ne 1121 461 

 
 

 
 
 
 



 

 

 

 

Locale ▾  
Language 

code 

LCID 
 
string 

LCID  

Decimal 

LCID 

Hexadecimal 

Norwegian - Bokml nb no-no 1044 414 

Norwegian - Nynorsk nn no-no 2068 814 

Oriya or or 1096 448 

Polish pl pl 1045 415 

Portuguese - Brazil pt pt-br 1046 416 

Portuguese - Portugal pt pt-pt 2070 816 

Punjabi pa pa 1094 446 

Raeto-Romance rm rm 1047 417 

Romanian - Moldova ro ro-mo 2072 818 

Romanian - Romania ro ro 1048 418 

Russian ru ru 1049 419 

Russian - Moldova ru ru-mo 2073 819 

Sami Lappish   1083  

Sanskrit sa sa 1103  

Serbian - Cyrillic sr sr-sp 3098  

Serbian - Latin sr sr-sp 2074  

Sesotho (Sutu)   1072 430 



 

 

 

Locale ▾  
Language 

code 

LCID 
 
string 

LCID  

Decimal 

LCID 

Hexadecimal 

Setsuana tn tn 1074 432 

Sindhi sd sd 1113 459 

Sinhala; Sinhalese si si 1115  

Slovak sk sk 1051  

Slovenian sl sl 1060 424 

Somali so so 1143 477 

Sorbian sb sb 1070  

Spanish - Argentina es es-ar 11274  

Spanish - Bolivia es es-bo 16394  

Spanish - Chile es es-cl 13322  

Spanish - Colombia es es-co 9226  

Spanish - Costa Rica es es-cr 5130  

Spanish - Dominican 
Republic 

es es-do 7178  

Spanish - Ecuador es es-ec 12298  

Spanish - El Salvador es es-sv 17418  

Spanish - Guatemala es es-gt 4106  

Spanish - Honduras es es-hn 18442  



 

 

 

Locale ▾  
Language 

code 

LCID 
 
string 

LCID  

Decimal 

LCID 

Hexadecimal 

Spanish - Mexico es es-mx 2058  

Spanish - Nicaragua es es-ni 19466  

Spanish - Panama es es-pa 6154  

Spanish - Paraguay es es-py 15370  

Spanish - Peru es es-pe 10250  

Spanish - Puerto Rico es es-pr 20490  

Spanish - Spain (Traditional) es es-es 1034  

Spanish - Uruguay es es-uy 14346  

Spanish - Venezuela es es-ve 8202  

Swahili sw sw 1089 441 

Swedish - Finland sv sv-fi 2077  

Swedish - Sweden sv sv-se 1053  

Syriac   1114  

Tajik tg tg 1064 428 

Tamil ta ta 1097 449 

Tatar tt tt 1092 444 

Telugu te te 1098  



 

 

 

Locale ▾  
Language 

code 

LCID 
 
string 

LCID 

 Decimal 

LCID 

Hexadecimal 

Thai th th 1054  

Tibetan bo bo 1105 451 

Tsonga ts ts 1073 431 

Turkish tr tr 1055  

Turkmen tk tk 1090 442 

Ukrainian uk uk 1058 422 

Unicode  UTF-8 0  

Urdu ur ur 1056 420 

Uzbek - Cyrillic uz uz-uz 2115 843 

Uzbek - Latin uz uz-uz 1091 443 

Venda   1075 433 

Vietnamese vi vi 1066  

Welsh cy cy 1106 452 

Xhosa xh xh 1076 434 

Yiddish yi yi 1085  

Zulu zu zu 1077 435 



 

 

VIII. Appendix 2 – Config.xml sample 

1. Config.xml 

This is a sample of the config.xml provided by the developer when submitting an 
application 

 
<?xml version="1.0"?> 
<Game xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 

 
<!-- Application Description --> 
<!-- default names, used for each languages unless specifically defined in the language section --> 
<Name>Bubble Pop</Name> 
<Description>Pop Bubbles!</Description> 
<Version>1.0</Version> 
<Developer>John Anderson</Developer> 
<Manufacturer>Company Name</Manufacturer> 

 
<!-- A relative path to the file executed by the client (.exe, .bat, etc.) --> 
<ExectionFile>bin\BubblePop.bat</ExectionFile> 

 
<!-- List of processes that are running.--> 
<!-- Needed for upgrade process and to avoid two instances running simultaneously --> 
<Processes> 

<Process>BubblePop.exe</Process> 
<Process>Launcher.exe</Process> 

</Processes> 
 

<!-- List of files that need to be unlocked after purchase. Without these files game cannot run --> 
<ProtectedFiles> 

<file>LauncherData\Game\BubblePop.exe</file> 
<file>LauncherData\Launcher.exe</file> 

</ProtectedFiles> 

 
<!-- System Requirements --> 
<OpenNIVersion>1.2.0.7</OpenNIVersion> 
<OS>Windows</OS> 
<!-- service pack, version, --> 

http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema


 

 

<Sensor>Xtion</Sensor> 
 

 
<!-- Store Images --> 
<InstallerName>setup-BubblePop-version-1.3</InstallerName> 
<Images> 

<Icon>BubblePop-icon-125X125.png</Icon> 
<Thumbnail>BubblePop-Thumb-309X229.png</Thumbnail> 
<Screenshot>screen01.jpg</Screenshot> 
<Screenshot>screen04.jpg</Screenshot> 
<Screenshot>screen07.jpg</Screenshot> 
<Screenshot>screen08.jpg</Screenshot> 

</Images> 
<Video>BubblePopPromo.avi</Video> 

 
<!-- PROBABLY NOT NEEDED --> 

 
<!-- Needed if appside will do the packing --> 
<Packaging> 

<Windows> 
<Registry> 

<Path>HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Bubble 
Pop</Path>  

<Entry> 
 

 
 
 

</Entry> 
<Entry> 

 

 
 
 

</Entry> 
<Entry> 

 

 
 
 

</Entry> 
</Registry> 

</Windows> 

 

 
<Name>PopInterval</Name> 
<Type>REG_SZ</Type> 
<Value>2</Value> 
 

 
<Name></Name> 
<Type></Type> 
<Value></Value> 
 

 
<Name></Name> 
<Type></Type> 
<Value></Value> 



 

 

</Packaging> 

 
<Languages> 

 
<Language> 

<Locale>French - France</Locale> 
 

<Name>BubblePop</Name> 
<Description>Pop Bubbles!</Description> 
<Header></Header> 

 
<Languages> 
</Language>



 

 

IX. Appendix 3 – Publishing on the Asus Xtion Store 

 
In order to publish applications and games which are compatible with the Asus 

Xtion solution, you can assume the following specs of the machine running the 

app: 

 

 

OS:                       Windows®  XP/Vista/7 

 
 

 

CPU: 
Intel®  Conroe Core processor or newer 
 
AMD Athlon™64 AM2 Socket or newer 

 
System Memory:  2GB 

 

 

Graphics Card:     Supports DX9.0 or above 
 

 

Graphics Memory: 1GB 
 

 

Resolution:           1280*720 screen resolution 
 

 

OpenNI version:   1.2.1.1 
 

 

Sensor driver:       5.0.2.3 
 
 
 

 
NITE version         1.3.1.9 

 
 

Note that you cannot assume your app will be running on a stronger machine 

than the above! 

 

If you have any questions, please kindly assist to contact via mail, 

Contact window: #xtionapp@asus.com 

mailto:#xtionapp@asus.com


 

 

X. 釋義 

一、 作業系統 

Windows，Android，Linux 

 
 

二、 感應器 

Primesense，Xtion 

 
 

三、 語言輸入法 

輸入法名稱字串—一條字串代表一種特定的語言，例如： 

zh-cn  中文——中國 

zh-hk  中文——香港 

zh-mo  中文——澳門 

zh-sg  中文——新加坡 

zh-tw  中文——台灣 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

XI. 開發程式 

一、 一般 

動作控制（或稱為“動態感應”）裝置正改變人們與遊戲及程式的互動方式。加入 AppSide 

Marketplace 參與到這場遊戲動作控制的革命中。銷量的重要性不言而喻，我們可以幫助

您進入這個市場，從而讓您分享並提供程式及遊戲。我們非常樂意與您一起在這個現有的

市場內工作。 

 
更專業化的開發 

有時一個看起來很糟糕的 app程式與一個看上去很專業的 app 程式之間的差異僅僅在於

一些簡單的使用者體驗及介面的操控。如果您想要在 AppSide Marketplace 中獲得一席之

地，您需求做一些額外的改變從而讓終端消費者心甘情願地掏錢購買您的作品。最簡單的

方法就是參考您最喜愛的 iOS 或 PC 遊戲來獲取靈感：如在載入過程中，在螢幕最顯眼的

地方依次呈現： 

  您的名稱/開發者名稱，如果有的話還要加入 Logo 

  中間件的 Logo，例如：OpenNI logo 

  主選單 

  想像一下一部電影開場時，製作組的畫面是怎樣呈現的，這正是你所需要的。 

  在主選單中： 

    顯眼地呈現遊戲的名稱，以及 logo（如果有的話） 

    展示一些簡潔明瞭的按鈕，諸如以下七個項目： 

    新遊戲，或開始遊戲，或進入遊戲 

    適用項目：“繼續遊戲” 

    適用項目：“載入遊戲” 

    新玩家（如果已經有的話，可設定為更改玩家） 

    選項 

    製作組 

    離開 

    簡單易懂的教程解釋遊戲中的動作 

    少而簡單的動作 

    關於遊戲的版權說明 

    欲查看選單項目，請伸出你的手並保持不動。如要離開，請兩 

    手交叉。 

 
二、 需求 

同螢幕模式—僅 720p 解析度



 

 

 

XII. 遊戲或程式名稱 

您開發的程式或遊戲的安裝資料夾名稱必須與眾不同。如果您為程式及遊戲選擇的名稱在 

AppSide Marketplace 上已經存在，那麼您需要選擇一個不同的名稱。 

如果您選擇的名稱已被其它程式所使用，您將會收到來自 AppSide Marketplace 的通知，

並請選擇不同的名稱。 

這部分內容我們將在 doc 文檔之後的 AppName 中提到。 

 
一、 架構 

本章節介紹了用於 Windows 作業系統的程式的架構 

 
二、 Windows 

您開發的程式必須由一個或更多的二進位檔案組成（exe, dll, lib, fla, jar 等）或其它檔案諸

如 xml, 圖片檔案，文本檔案，config 檔案，聲音檔案等。 

 
三、 二進位檔案 

所有的二進位檔案必須安裝在 %ProgramFiles%\AppName 

（win 32 bit 系統-“C:\ Program Files\AppName” 

win 64 bit 系統-“C:\ Program Files(x86)\AppName”） 

 
這些檔案可能會直接安裝完畢，或另行安裝在一個子資料夾內，諸如 bin. 

二進位檔案必須在編輯后，可在 32-bit 的裝置執行。 

 
四、 資料檔案 

所有其它形式的檔案必須安裝在”%ProgramData%\AppName” 

(“C:\ProgramData\AppName”)中。 

如 config 等非使用者更新及在安裝時改寫的檔案，可寫在 “C:\Program 

Files(x86)\AppName”下 

 
五、 使用者專有檔案 

儲存有使用者專有資料諸如設定的資料夾必須寫在”%appdata%\AppName”下， 

(“C:\Users\username\AppData\Roaming\AppName”) 
 

六、 可更新檔案 

可更新檔案必須寫在”%ProgramData&\AppName”或 

“%appdata%\AppName”下，如諸上所述



 

 

XIII. 提交程式 

一、 測試程式 

在提交程式前，請先完整地測試遊戲。有故障或者不符合 AppSide Marketplace 標準的程

式將被退回。 

 
二、 建立商店圖片 

要想在 AppSide Marketplace 中顯示遊戲，您必須按照以下規則先建立遊戲的圖示，縮圖

及螢幕截圖： 

1. 建立圖示，需要一張畫素為 512 x 512，png格式的正方形圖片檔案。 

2. 建立縮圖，需要一張寬長比為 3:4，最小尺寸為 400 x 300 畫素，png 格式的長方形圖

片檔案。 

3. 建立從遊戲中選取的螢幕截圖（最多 4 張），需要寬長比為 3:4，最小尺寸為 1200 x 

900 畫素，jpg 格式的圖片檔案。 

4. 可附加影片檔案。 

每張圖片的大小必須在 300KB 以下。 

三、 提交至 AppSide Marketplace 

提交已開發完成的遊戲需要 3個步驟： 

1. 建立一個包含程式名稱及版本資訊的資料夾(AppName_v1.0) 

在這個資料夾下，建立 4個子資料夾： 

App——所有儲存在”C:\Program Files (x86)\AppName”下的檔案 

ProgramData——所有儲存在”%ProgramData%\AppName” 下的檔案 

AppData——所有儲存在”%appdata%\AppName”下的檔案 

StoreImages——需要在 AppSide MarketPlace 中使用的圖標，縮略圖及截屏 

2. 以 .zip 的格式壓縮打包根資料夾，資料夾名稱為：程式名稱及版本資訊

(AppName_v1.0.zip) 
3. 填寫 AppSide 設定 XML： 

<ApplicationName> App Name 
</ApplicationName> 

預設語言的程式名稱 

<AppInstallName>AppName</AppInstallName> 在 ProgramFiles，

Program Data及 registry

下，安裝程式的目標資料夾

名稱 

<Description>Application 
description</Description> 

以預設語言呈現的程式描述

將會顯示在商店中 遊戲/程

式 的頁面和 Xtion 網頁

內。 

<Developer>developer name</Developer>  

<Images> 
  <Icon>BubblePop-icon.png</Icon> 
  <Thumbnail>BubblePop-
Thumb.png</Thumbnail> 

 



 

 

  <Screenshot>screen01.jpg</Screenshot> 
<Screenshot>screen04.jpg</Screenshot> 
<Screenshot>screen07.jpg</Screenshot> 
<Screenshot>screen08.jpg</Screenshot> 

<Images> 

<Video>BubblePopPromo.avi</Video>  

<builds> 目標劃分的清單 

  <build> 用於每個目標劃分 

    <FileInfo> 用於每個目標劃分的檔案參

數 

      <ExecutionFile>game.bat<ExecutionFile> 到執行程式檔案的相關路徑

（從 App 目錄起） 

<Processes> 
  <Process>AppName.exe</Process> 
  <Process>Launcher.exe</Process> 
<Processes> 

正在執行的流程列表。更新

流程必需，以避免兩個請求

同時執行。 

<ProtectedFiles> 
  <file>LauncherData\Game\game.exe</file> 
  <file>LauncherData\Launcher.exe</file> 
<ProtectedFiles> 

到需要透過 DRM保護的檔

案的相關路徑（從 App 目

錄起） 

  

  </FileInfo>  

  <TargetInfo> 用於每個目標劃分的目標參

數 

<OpenNIVersion></OpenNIVersion>  

<OS></OS>  

<Sensor></Sensor>  

  </TargetInfo>  

 </build>  

</builds>  

<Languages>  

 <Language> 對於每種語言在接下來的節

點後都會有一個節點 

    <Locale>locale name</Locale> 語言輸入法。輸入法清單請

見附錄 1及樣本

config.xml 。 

    <Name>AppName</Name> 依據語言所顯示的程式名

稱。如空白將使用預設語

言。 

    <Description>Cool App!</Description> 依據語言所顯示的描述。如

空白將使用預設語言。 

  </Language>  

</Language>  



 

 

XIV. 詳細劃分 

一、 一般 

詳細劃分的定義為以一組裝置或使用者為目標，收到程式確定的外觀、感受及功能。 

詳細劃分的最佳例子為，來自某個國家的使用者說著某種語言。作為開發者要將資訊及文

本以使用者母語的形式呈現給使用者。 

 
二、 執行 

每個包含一系列不同檔案及壓縮檔案的遊戲場景內容，都必須提供所有有關的檔案。 

每個這樣的構造都包含獨立的檔案及 confi.xml 中的目標設定。 

 
三、 最佳實例 

為支援詳細劃分，開發者需按照每個程式都有一份拷貝，能依據不同的設定或使用者的輸

入顯示不同內容這樣的方法來建立程式。 

 
舉例： 

程式包含一個名為語言的資料夾。 

在此資料夾內又包含若干不同語言的資料夾。 

每種語言的資料夾內包含所有此種語言的文本、設定、圖像及聲音檔案。 

 
依據使用者選擇的語言或作業系統輸入法的自動偵測，程式將使用對應的語言資料夾內的

檔案。 

 
建議減少使用圖像及聲音檔案來詳細劃分，儘量使用設定及文本檔案替代。 

 
舉例： 

不建議在圖片檔案內插入標題，而是將標題放在圖片上。 

在這種詳細劃分的情況下，程式只有一張圖片但同時具有多份已翻譯的文本檔案，這樣就

替代了同樣圖片的多份拷貝，從而減少了程式的大小。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

XV. 版本 

一、 一般 

程式每次上傳到 AppSide Marketplace 后就會收到一個版本號。 

版本是開發者與 AppSide Marketplace 之間重要的溝通資訊，請開發者務必牢記版本號。 

 
 

XVI. 更新 

一、 一般 

與提交程式相似 

將遊戲檔案及相關參數提交給 AppSide。AppSide 將處理程式的 DRM，打包及更新。 

 
如何提交程式的新版本，請參考“提交程式”一章節。 

 
 
 

XVII. 附錄 1——輸入法清單 

輸入法 語言代碼 LCID 字串 LCID 十進位 LCID 十六進位 

南非荷蘭語 af af 1078 436 

阿爾巴尼亞語 sq sq 1052  

阿姆哈拉語 am am 1118  

阿拉伯語—阿爾

及利亞 

ar ar-dz 5121 1401 

阿拉伯語—巴林 ar ar-bh 15361  

阿拉伯語—埃及 ar ar-eg 3073  

阿拉伯語—伊拉

克 

ar ar-iq 2049 801 

阿拉伯語—約旦 ar ar-jo 11265  

阿拉伯語—科威

特 

ar ar-kw 13313 3401 

阿拉伯語—黎巴

嫩 

ar ar-lb 12289 3001 

阿拉伯語—利比

亞 

ar ar-ly 4097 1001 

阿拉伯語—摩洛

哥 

ar ar-ma 6145 1801 

阿拉伯語—阿曼 ar ar-om 8193 2001 

阿拉伯語—卡塔

爾 

ar ar-qa 16385 4001 



 

 

阿拉伯語—沙特

阿拉伯 

ar ar-sa 1025 401 

阿拉伯語—敘利

亞 

ar ar-sy 10241 2801 

阿拉伯語—突尼

斯 

ar ar-tn 7169  

阿拉伯語—阿拉

伯聯合酋長國 

ar ar-ae 14337 3801 

阿拉伯語—也門 ar ar-ye 9217 2401 

亞美尼亞語 hy hy 1067  

阿薩姆語 as as 1101  

阿塞拜疆語—西

裡爾字母 

az az-az 2092  

阿塞拜疆語—拉

丁字母 

az az-az 1068  

巴斯克語 eu eu 1069  

白俄羅斯語 be be 1059 423 

孟加拉語—孟加

拉國 

bn bn 2117 845 

孟加拉語—印度 bn bn 1093 445 

波斯尼亞語 bs bs 5146  

保加利亞語 bg bg 1026 402 

緬甸語 my my 1109 455 

加泰羅尼亞語 ca ca 1027 403 

中文—中國 zh zh-cn 2052 804 

中文—香港特別

行政區 

zh zh-hk 3076  

中文—澳門特別

行政區 

zh zh-mo 5124 1404 

中文—新加坡 zh zh-sg 4100 1004 

中文—台灣 zh zh-tw 1028 404 

克羅地亞語 hr hr 1050  

捷克語 cs cs 1029 405 

丹麥語 da da 1030 406 

迪維西語—馬爾

代夫 

dv dv 1125 465 

荷蘭語—比利時 nl nl-be 2067 813 

荷蘭語—荷蘭 nl nl-nl 1043 413 

埃多語   1126 466 

英語—澳大利亞 en en-au 3081  



 

 

英語—伯里茲 en en-bz 10249 2809 

英語—加拿大 en en-ca 4105 1009 

英語—加勒比 en en-cb 9225 2409 

英語—英國 en en-gb 2057 809 

英語—印度 en en-in 16393 4009 

英語—愛爾蘭 en en-ie 6153 1809 

英語—牙買加 en en-jm  8201 2009 

英語—新西蘭 en en-nz 5129 1409 

英語—菲律賓 en en-ph 13321 3409 

英語—南非 en en-za 7177  

英語—特立尼達 en en-tt 11273  

英語—美國 en en-us 1033 409 

英語—津巴布韋 en  12297 3009 

愛沙尼亞語 et et 1061 425 

馬其頓語 mk mk 1071  

法羅語 fo fo 1080 438 

波斯語 fa fa 1065 429 

菲律賓語   1124 464 

芬蘭語 fi fi 1035  

法語—比利時 fr fr-be 2060  

法語—喀麥隆 fr  11276  

法語—加拿大 fr fr-ca 3084  

法語—剛果 fr  9228  

法語—科特迪瓦 fr  12300  

法語—法國 fr fr-fr 1036  

法語—盧森堡 fr fr-lu 5132  

法語—馬里 fr  13324  

法語—摩納哥 fr  6156  

法語—摩洛哥 fr  14348  

法語—塞內加爾 fr  10252  

法語—瑞士 fr fr-ch 4108  

法語—西印度群

島 

fr  7180  

弗里斯蘭語—荷

蘭 

  1122 462 

蓋爾語—愛爾蘭 gd gd-ie 2108  

蓋爾語—蘇格蘭 gd gd 1084  

加利西亞語 gl  1110 456 

格魯吉亞語 ka  1079 437 

德語—奧地利 de de-at 3079  



 

 

德語—德國 de de-de 1031 407 

德語—列支敦士

登 

de de-li 5127 1407 

德語—盧森堡 de de-lu 4103 1007 

德語—瑞士 de de-ch 2055 807 

希臘語 el el 1032 408 

瓜拉尼語—巴拉

圭 

gn gn 1140 474 

古吉拉特文 gu gu 1095 447 

HID（人機連接

埠裝置） 

  1279  

希伯來語 he he 1037  

印地語 hi hi 1081 439 

匈牙利語 hu hu 1038  

冰島語 is is 1039  

伊布語—尼日利

亞 

  1136 470 

印度尼西亞語 id id 1057 421 

意大利語—意大

利 

it it-it 1040 410 

意大利語—瑞士 it it-ch 2064 810 

日語 ja ja 1041 411 

坎那達語 kn kn 1099  

克什米爾語 ks ks 1120 460 

哈薩克語 kk kk 1087  

高棉語 km km 1107 453 

貢根語   1111 457 

韓語 ko ko 1042 412 

吉爾吉斯語—西

裡爾字母 

  1088 440 

老撾語 lo lo 1108 454 

拉丁語 la la 1142 476 

拉脫維亞語 lv lv 1062 426 

立陶宛語 lt lt 1063 427 

馬來語—文莱 ms ms-bn 2110  

馬來語—馬來西

亞 

ms ms-my 1086  

馬拉雅拉姆語 ml ml 1100  

馬爾他語 mt mt 1082  

曼尼普爾語   1112 458 



 

 

毛里語 mi mi 1153 481 

馬拉地語 mr mr 1102  

蒙古語 mn mn 2128 850 

蒙古語 mn mn 1104 450 

尼泊爾語 ne ne 1121 461 

挪威語—博克馬

爾 

nb no-no 1044 414 

挪威語—耐諾斯

克 

nn no-no 2068 814 

奧利亞語 or or 1096 448 

波蘭語 pl pl 1045 415 

葡萄牙語—巴西 pt pt-br 1046 416 

葡萄牙語—葡萄

牙 

pt pt-pt 2070 816 

旁遮普語 pa pa 1094 446 

拉托—羅馬語 rm rm 1047 417 

羅馬尼亞語—摩

爾多瓦 

ro ro-mo 2072 818 

羅馬尼亞語—羅

馬尼亞 

ro ro 1048 418 

俄羅斯語 ru ru 1049 419 

俄羅斯語—摩爾

多瓦 

ru ru-mo 2073 819 

薩米拉普語   1083  

梵語 sa sa 1103  

塞爾維亞語—西

裡爾字母 

sr sr-sp 3098  

塞爾維亞語—拉

丁字母 

sr sr-sp 2074  

塞索托語（蘇圖

語） 

  1072 430 

Setsuana tn tn 1074 432 

信德語 sd sd 1113 459 

錫蘭語;僧伽羅語 si si 1115  

斯洛伐克語 sk sk 1051  

斯洛文尼亞語 sl sl 1060 424 

索马里語 so so 1143 477 

索布語 sb sb 1070  

西班牙語—阿根

廷 

es es-ar 11274  



 

 

西班牙語—玻利

維亞 

es es-bo 16394  

西班牙語—智利 es es-cl 13322  

西班牙語—哥倫

比亞 

es es-co 9226  

西班牙語—哥斯

達黎加 

es es-cr 5130  

西班牙語—多米

尼加共和國 

es es-do 7178  

西班牙語—厄瓜

多爾 

es es-ec 12298  

西班牙語—薩爾

瓦多 

es es-sv 17418  

西班牙語—危地

馬拉 

es es-gt 4106  

西班牙語—洪都

拉斯 

es es-hn 18442  

西班牙語—墨西

哥 

es es-mx 2058  

西班牙語—尼加

拉瓜 

es es-ni 19466  

西班牙語—巴拿

馬 

es es-pa 6154  

西班牙語—巴拉

圭 

es es-py 15370  

西班牙語—秘魯 es es-pe 10250  

西班牙語—波多

黎各 

es es-pr 20490  

西班牙語—西班

牙（標準） 

es es-es 1034  

西班牙語—烏拉

圭 

es es-uy 14346  

西班牙語—委內

瑞拉 

es es-ve 8202  

斯瓦西裡語 sw sw 1089 441 

瑞典語—芬蘭 sv sv-fi 2077  

瑞典語—瑞典 sv sv-se 1053  

敘利亞語   1114  

塔吉克語 tg tg 1064 428 

泰米爾語 ta ta 1097 449 



 

 

鞑靼语 tt tt 1092 444 

特拉古文 te te 1098  

泰语 th th 1054  

藏语 bo bo 1105 451 

汤加语 ts ts 1073 431 

土耳其语 tr tr 1055  

土库曼语 tk tk 1090 442 

烏克蘭語 uk uk 1058 422 

萬國碼  UTF-8 0  

烏爾都語 ur ur 1056 420 

烏茲別克語—西

裡爾字母 

uz uz-uz 2115 843 

烏茲別克語—拉

丁字母 

uz uz-uz 1091 443 

文達   1075 433 

越南語 vi vi 1066  

威爾士語 cy cy 1106 452 

科薩語 xh xh 1076 434 

祖魯語 zu zu 1077 435 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

XVIII. 附錄 2—Config.xml 樣本 

一、 Config.xml 
以下為開發者提交程式的 config.xml 的樣本 

 
<?xml version="1.0"?>  
<Game xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:xsd="http://www.w3.org/2001/XMLSchema">  
<!-- Application Description -->  
<!-- default names, used for each languages unless specifically defined in the language section -->  
<Name>Bubble Pop</Name>  
<Description>Pop Bubbles!</Description>  
<Version>1.0</Version>  
<Developer>John Anderson</Developer>  
<Manufacturer>Company Name</Manufacturer>  
<!-- A relative path to the file executed by the client (.exe, .bat, etc.) -->  
<ExectionFile>bin\BubblePop.bat</ExectionFile>  
<!-- List of processes that are running.-->  
<!-- Needed for upgrade process and to avoid two instances running simultaneously -->  
<Processes>  
<Process>BubblePop.exe</Process>  
<Process>Launcher.exe</Process>  
</Processes>  
<!-- List of files that need to be unlocked after purchase. Without these files game cannot run -->  
<ProtectedFiles>  
<file>LauncherData\Game\BubblePop.exe</file>  
<file>LauncherData\Launcher.exe</file>  
</ProtectedFiles>  
<!-- System Requirements -->  
<OpenNIVersion>1.2.0.7</OpenNIVersion>  
<OS>Windows</OS>  
<!-- service pack, version, -->  
<Sensor>Xtion</Sensor>  
<!-- Store Images -->  
<InstallerName>setup-BubblePop-version-1.3</InstallerName>  
<Images>  
<Icon>BubblePop-icon-125X125.png</Icon>  
<Thumbnail>BubblePop-Thumb-309X229.png</Thumbnail>  
<Screenshot>screen01.jpg</Screenshot>  
<Screenshot>screen04.jpg</Screenshot>  
<Screenshot>screen07.jpg</Screenshot>  
<Screenshot>screen08.jpg</Screenshot>  
</Images>  
<Video>BubblePopPromo.avi</Video>  
<!-- PROBABLY NOT NEEDED -->  
<!-- Needed if appside will do the packing -->  
<Packaging>  
<Windows>  
<Registry>  
<Path>HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Bubble Pop</Path>  
<Entry>  
<Name>PopInterval</Name>  
<Type>REG_SZ</Type>  
<Value>2</Value>  



 

 

</Entry>  
<Entry>  
<Name></Name>  
<Type></Type>  
<Value></Value>  
</Entry>  
<Entry>  
<Name></Name>  
<Type></Type>  
<Value></Value>  
</Entry>  
</Registry>  
</Windows>  
</Packaging>  
<Languages>  
<Language>  
<Locale>French - France</Locale>  
<Name>BubblePop</Name>  
<Description>Pop Bubbles!</Description>  
<Header></Header>  
</Language>  

<Languages> 
 
 
 
 
 
 
 
 

XIX. 附錄 3——在華碩 Xtion Store 上發佈 

欲在華碩 Xtion Store 上發佈程式及遊戲，請參考以下系統需求： 

 
作業系統：  Windows® XP/Vista/7 

CPU：   Intel®  Core i3 處理器或以上 

    AMD® Athlon™64 AM2 Socket 或以上 

系統記憶體： 2GB 

顯示卡：  支援 DX9.0 或更新版本 

顯示記憶體： 1GB 

解析度：  1280 x 720 螢幕解析度 

OpenNI 版本： 1.2.1.1 

感應器讀懂程式：5.0.2.3 

NITE 版本：  1.3.1.9 

 
請注意：請勿假設您的程式可在比以上配置更高的機器上運作！ 

如果有任何開發上或商業合作的問題，請聯絡以下窗口 

聯絡窗口: #xtionapp@asus.com 

 

mailto:#xtionapp@asus.com

